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NOTICE 

This manual is the Music System Installation and Operation Manual v1.0. 

All rights reserved. No part of this document may be reproduced or transmitted in any form, 
by any means (electronic, photocopying, recording, or otherwise) without the prior written 
permission of Aleen Technologies. 

The trademark and service marks Aleen, including the Aleen mark and logo, are the exclusive 
property of Aleen Technologies, and may not be used without permission. All other marks 
mentioned in this material are the property of their respective owners. 

Additional copies of this manual may be obtained from Aleen. Reproduction of this manual 
or parts thereof without written permission from Aleen is strictly prohibited. 

Aleen reserves the right to modify the hardware and software described in the manual without 
prior notice. However, changes made to the hardware or software described does not 
necessarily render this publication invalid. 

WARRANTY 

In the event that the product proves to be defective in workmanship or materials within a 
period of one year from date of shipment, Aleen shall repair or replace the product at its 
discretion. Transportation will be the responsibility of the dealer/distributor. Under no 
circumstances shall Aleen be liable for consequential or special damages, loss of revenue 
or user/dealer expenses arising out of or in connection with the use or performance of 
the product, whether based on contract, tort, or any other legal agreement. 

The following shall void the above warranty: malfunctions resulting from fire, accident, 
neglect, abuse, or acts of God; use of improper electrical power; or repair of, tampering with 
or alteration of the product by anyone other than Aleen authorized personnel. 
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1. Introduction 

1.1 Manual Audience and Contents 
The Music System Installation and Operation Manual is intended for System Installers and 
Administrators, responsible for the installation, setup and programming of the Music System. 

Note: 

Please read this manual before the installation, programming and operation of the Music 
System. 

This manual contains the following: 
Chapter Heading   

1 Introduction   

2 Installation   

3 Music Software   

4 MP3 File Size Calculation Table   

1.2 System Description 

1.2.1 General Description 
The Music System is one of Aleen’s unique Music and Messaging on Hold solutions that can 
be controlled via the LAN. It can be remotely programmed through IP connectivity and can, 
depending on the file size, hold up to 100 MP3 music/messaging files. 

The Music System offers 32Mb of recording space and has an internal clock to schedule 
daily, weekly and holiday playback lists. 

The E-RAP (IP – Remote Access Program) is a central administration program that handles 
all client databases. E-RAP is capable of uploading MP3 music files to thousands of remote 
specific Music Systems via the IP network. 

The MUP (Music Utility Program) is used for configuring and maintaining the Music 
System. The user-friendly MUP is capable of uploading configuration information to and 
downloading it from the Music System. 

The configuration file contains the list of announcement messages, predefined schedules for 
playing messages, adjustments of the volume level via software, flash memory usage 
statistics and other configuration settings. 
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The MUP can perform a Full Backup and Restore of the Music System configuration 
information, using an IP connection. 

Main Features: 
z Stand-alone device 

z Up to 32Mb storage memory 

z 1 Audio output (either for an 600Ω or 8Ω connection) 

z High quality audio  

z E-RAP utility for remote programming 

z Local utility program (MUP) 

z Programmable via Network or RS-232 connection 

z Ethernet connection 

z Supports MP3 format 

z Daily task scheduler 

1.2.2 Physical Description 
The Music System has been designed to fit in the same housing as the rest of the Aleen Music 
family of products. 

 
Figure  1-1: Front View 
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The front view shows a number of indicators, which have been described below. 

 
Figure  1-2: Indicators 

Indicator Color Function 
Power Green Indicates that the power is on 
Playback Red Indicates that information is played back to a caller 
TxD/RxD Yellow Indicates that the Music System is in the data 

transfer/receive mode  
LAN Link Green Indicates that the Music System is connected to and 

accessed via the LAN 
 

Figure  1-3: Side View – Connectors 

 
Connector Function 

9V DC Connection of Power Supply 
RS-232 Connection to PC 
Ethernet Network connection 
Output - 8Ω Connection to the PABX (see note) 
Output – 600Ω Connection to the PABX (see note) 
Ext. Audio In Connection from external audio device 

Notes: 

The Music System can only be connected to one PABX at a time. 

The Audio output and Audio input are only Mono. 
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1.2.3 Technical Data 

1.2.3.1 Programming Cable Specifications 

The Music System comes with a special programming cable. The following picture describes 
that cable: 

 
Figure  1-4: RS-232 Cable specifications 

1.2.3.2 Network Cable Specifications 

The Music System comes with a network cable. The specifications are: 

 
Figure  1-5: Network cable 
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1.2.3.3 Technical Specifications 

Memory Capacity 32MB 

Local Utility Program MUP 

Remote Download E-RAP 

Ethernet Connection RJ-45 socket (10/100Mbps) 

Serial Communication Port RJ-11 socket (RS-232 up to 115000 bps) 

Supported Voice Format MP3 

Daily Task Scheduler Yes 

Maximum Number of Recorded Files Depending on File size up to 100 

Programmable  RS-232 or network (using TCP/IP 
capabilities) 

Real-Time Clock Yes 

Watch Dog Yes 

Flash Memory For 32MB recording time and 32MB buffer 

Display 4 LED’s 

Audio output to audio equipment Up to 2.0V p-p@ on impedance 8Ω (3.5mm 
mono/stereo audio socket) 

Audio output to PBX Up to 1.5V p-p@ on impedance 600Ω (RJ-11 
socket, pin 2 and 3) 

Audio input from external devices Up to 0dB audio input > 10kΩ (3.5mm 
mono/stereo audio socket) 

Power Supply 
        Input: 
 
        Output 

 
110VAC, 60Hz 
220VAC, 50Hz 
9VDC, 800mA  

Dimensions (HxWxD) 200x220x30mm 
7.9x8.7x1.2 inch 
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1.3 Workflow 
The following picture shows a schematic overview of a basic installation of the Music 
System: 

 
Figure  1-6: Music System Quick Installation Flow 
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2. Installation 

2.1 Unpacking 
The following table describes the contents of the Music System package. 

Note: 

Should the package be damaged or should items from the packing list be missing, contact 
your distributor directly. 

 

Nr. Item Quantity 

1 Music System 1 

2 Installation CD with MUP software, Manual, E-
RAP software, MP3 examples 

1 

3 Power Supply (Input: 110VAC, 60Hz or 220VAC, 
50Hz)(Output 9VDC, 800mA) 

1 

4 Network cable RJ-45 – RJ-45 1 

5 RS-232 cable D-Type 9 pin – RJ-11 1 

6 Screws and plugs 2 

7 Drill template 1 
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2.2 General Installation Information 
The following picture shows an example of a setup for the Music System: 

LAN Server

LAN TCP/IP

Gateway

LAN Server

LAN TCP/IP

Music-Tel-E

Firewall

Firewall

Internet

Remote PC

Local IP
192.168.21.100

NAT
Network Addresses Translation

Legal IP                      Local IP
66.100.100.128      192.168.21.100

Port 500 TCP and UDP

Port 10254 TCP

Gateway IP Address
XXX.XXX.XXX.XXX

MUP

 
Figure  2-1: Music System Remote Setup 

The picture shows a remote setup, where the PC connects to the Music System through 
firewalls and the Internet. Before the remote setup can work, the Music System needs to be 
initialized locally. This initial installation process is done by linking a PC and the Music 
System locally via the RS-232 connection as has been described in the following chapter. 

During the initial installation process the Music System has to be defined in Network Settings 
and the Device Selection window of the MUP program. In the Network Settings window you 
will have to insert the IP Address of the Music System, Subnet Mask and Gateway IP 
Address (all provided by your local network administrator). In the Device Selection window 
the Music System entry has to be added . It needs to be named and its IP Address needs to be 
inserted. When using a PC for connecting to the Music System, the filled in IP address is 
sufficient for the MUP to find it locally or remote.  

The MUP uses the TCP protocol and port 10254 is used for the data-transfer between the 
MUP and the Music System. 
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2.3 Music System Installation Instructions 
z Connect the Music System via its RS-232 socket to the COM port of the PC 

z Connect the Power Supply to the Music System 

Now the initial software installation of the Music Utilities can start. 

To install the MUP and E-RAP software on the PC: 

z Insert the CD in the Drive 

z Run the Music System Utility software (SETUP.EXE) 

z Run the MUP program from Start/Programs/Music System Utility Programs 1.xx 

z Click on Parameters/Network Settings 

 
z Fill in the IP address information (IP Address, Subnet Mask and Gateway IP Address) 

z Click on OK 
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z Make sure that you have chosen the correct COM port 

 
z Click on OK 

Now the IP Address has been set. Either continue with the installation via the RS-232 
connection (locally) or disconnect the RS-232 connection and configure the Music System 
from a remote location (within the local domain or in a remote domain) via the Ethernet 
connection. When deciding to configure the Music System from a remote location via the 
Ethernet connection, the network cable needs to be connected to the Ethernet socket on the 
Music System. It should be clear that when you are going to use a PC from a remote domain, 
you will access the Music System via the Internet. This connection is less secure than with a 
VPN (Virtual Private Network) connection. 

The following paragraph describes the procedure for Remote Access using VPN (Virtual 
Private Network). 

2.4 Remote Access using VPN 
Contrary to the remote access possibility via the Internet, remote access via VPN is a secure 
connection. For this you will first have to download/install the appropriate VPN software. A 
schematic overview of the Remote Setup via VPN is as follows: 
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LAN Server

LAN TCP/IP

Gateway

LAN Server

LAN TCP/IP

Music-Tel-E

Firewall

Firewall

Internet

Remote PC

Local IP
192.168.21.100

Port 500 TCP and UDP

Port 10254 TCP

Gateway IP Address
XXX.XXX.XXX.XXX

MUP
Remote PC with VPN

client installed.
User Name: XXXX
Password: XXXX

To
192.168.21.100

 
Figure  2-2 Music System Remote Setup via VPN 

The following paragraph will illustrate this with the installation and configuration of the 
Check Point VPN-1 SecuRemote/SecureClient NG – Feature Pack 3 software. This is one of 
the possible VPN packages. 
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2.4.1 Installation of the VPN Software 
1) Run the Setup.exe and the following screen will appear: 

 
2) Click on Next 
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3) Click on Yes (after reading and accepting the License Agreement) 

 
4) If needed, change the Destination folder by clicking on the Browse button and click on 

Next 

 
5) Select “Install VPN-1 SecuRemote” by clicking on the radio button before the installation 

to be selected 

6) Click on Next 
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7) Select “Install on all network adapters only” by clicking on the radio button before the 

installation to be selected 

8) Click on Next 

 
9) If needed, read the README file or click on No 

After the installation the last installation window will appear: 
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10) Select “Yes, I want to restart my computer now” by clicking on the radio button before 

this line of text. 

11) Click on Finish 

The computer will reboot and after the startup, you will see an icon of an envelope with a 
golden key on it. 

12) Click on the icon 

13) Click on Tools/Advanced IKE Settings 

14) Mark both “Force UDP encapsulation” and “Support IKE over TCP” 

15) Click on OK 

16) Click on Sites/Create New 

17) Enter the IP Address of the Firewall of the Target LAN in the Name/IP box 

18) Click on OK 

19) Insert your username and password accepted in the VPN network 

20) Click on OK 3 times until you see the icon resembling two buildings with the previously 
entered IP Address 

21) Right click on My Network Places and select Properties 

22) Right click on the Local Area Network or Dial-up Connection icon and select Properties 

23) Double click on Internet Protocol TCP/IP 

24) Click on the Advanced button 

25) Click on the WINS tab 

26) Click on Add and add the IP Address of your Target LAN WINS server 
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27) Close all windows with OK 

This finalizes the complete installation and configuration of the VPN software. Now you can 
connect to the Music System with MUP as if you are in the same domain as the Music 
System. 
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3. Music Software 

3.1 General 
The initial installation of the Music software is simple as described in the previous chapter. 
The MUP and E-RAP software and their Help files have been added to a menu under the 
Start/Programs menu. In this Chapter the Music Utility Program (MUP) will be described. 
The E-RAP software will be described at a later stage. 

3.2 Music Utility Program (MUP) 
The MUP is a user-friendly program, which helps you to configure the Music System. The 
toolbar and menus are discussed in the following paragraphs.  

Notes: 

Remember that for all actions you will have to have the Music System device selected. 
Should you have forgotten this, the program will inform you and guide you to the Device 
Selection menu. 

When performing configuration related tasks (backup, restore, etc.), make sure that the 
running tasks have been stopped (change the end time in the Task schedule). Don’t forget to 
activate this task after the configuration related task has been performed. 

When making a change in the configuration (e.g. changing the volume level of an Audio file), 
the change will only become active after you have sent the information to the device via the 
Send Configuration function. 
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Figure  3-1: MUP Main Screen 

The following function buttons can be pressed on the main screen’s toolbar: 

Button Function 

 
New – Starts a new MUP configuration file 

 
Open – Opens an existing MUP 
configuration file 

 
Save – Saves the open MUP configuration 
file 

 
Print – Prints the contents of the open MUP 
configuration file 
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The following menu’s can be accessed via the main screen: 

Menu Item Functions in Menu Item 

File New, Open, Close, Save, Save As, Open 
Default, Print, Print Preview, Print Setup, 
Recent File, Options, Exit 

View Toolbar, Status Bar 

Communication Read Configuration, Send Configuration, 
Read Recordings, Upgrade Recordings, 
Backup, Restore, Software Upgrade, 
Communication Selection, Password, Reset 

Parameters Network Settings, Date & Time 

Tasks Task Editor, Task Schedule  

Statistics General 

Help Help Topics, About MUP 

3.2.1 File Menu 
The File menu contains the following functions: 

Function Description 

New Start a new MUP configuration file 

Open Open an MUP configuration file 

Close Close the current configuration file 

Save Save an MUP configuration file 

Save As Save an MUP configuration file under a 
different name 

Open Default Open the default MUP configuration file 

Print Print the contents of the configuration file 

Print Preview Preview the information to be printed 

Print Setup Setup the printer for printing 

Recent File Recently used files 

Options File location options 

Exit Exit the program 
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3.2.1.1 New 

To start a new MUP configuration file: 

z Click on File 

z Click on New 

Now you will start with an empty MUP configuration file. 

3.2.1.2 Open 

To open an MUP configuration file from your local hard drive or the network: 

z Click on File 

z Click on Open 

 
z Browse for the required file and select it 

z Click on Open in the open window 

The configuration file will be loaded. 

3.2.1.3 Close 

To close the current MUP configuration file: 

z Click on File 

z Click on Close 

The current file will be closed, without saving or uploading the file to the Music System. 
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3.2.1.4 Save 

To save an MUP configuration file to your local hard drive or the network: 

z Click on File 

z Click on Save 

The current file will be saved in the previously defined location on the hard drive or the 
network. 

3.2.1.5 Save As 

To save an MUP configuration file with a new name or to save a new MUP configuration file 
on the hard drive or the network: 

z Click on File 

z Click on Save As 

 
z Select the location to where you want to save the MUP configuration file 

z Insert the name for the MUP configuration file 

z Click on Save in the Save As window 

The current file will be saved in the specified location, with the specified name. 

3.2.1.6 Open Default 

To open the default MUP configuration file: 

z Click on File 

z Click on Open Default 

The default MUP configuration file will be opened. 
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3.2.1.7 Print 

To print the contents of the open MUP configuration file: 

z Click on File 

z Click on Print 

 
z If needed, change the printer properties, Print range and number of copies 

z Click on OK 

The required printout will be printed. 
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3.2.1.8 Print Preview 

To preview the contents of the open MUP configuration file: 

z Click on File 

z Click on Print Preview 

 
In this window you can activate the Print function, zoom in and out, show 1 or 2 pages and 
close the window. 
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3.2.1.9 Print Setup 

To setup the print result: 

z Click on File 

z Click on Print Setup 

 
z If needed, modify the attached printer, paper size and orientation 

z Click on OK 

The printer has now been setup to provide you with the required print result. 

3.2.1.10 Recent File 

This section in the File menu shows the files you recently opened, during the ongoing 
session. 
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3.2.1.11 Options 

To define the location of the files created by the Music System: 

z Click on File 

z Click on Options 

z Select the file for which you want to define the location 

z Click on Set 

z Define the locations 

z Click on OK 

z Click on Ok 

Repeat the steps for the different files shown in the following picture. 

 
Note: 

The description of the file types can be found in Chapter 3.3. 

3.2.1.12 Exit 

To exit the Music Utility Program: 

z Click on File 

z Click on Exit 

The Music Utility Program will now be closed without saving the current open file. Should 
you want to save the changes made in the current MUP configuration file, please use 
File/Save or File/Save As first. 
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3.2.2 View Menu 
The View menu contains the following functions: 

Function Description 

Toolbar Show a row with buttons under the menus 

Status Bar Show status information at the bottom of the 
main screen 

3.2.2.1 Toolbar 

To view the Toolbar: 

z Click on View 

z Click on Toolbar 

 
The Toolbar function will be marked in the View menu. This will show a row with buttons 
under the menus. 

3.2.2.2 Status Bar 

To view the Status Bar: 

z Click on View 

z Click on Status Bar 

 
The Status Bar function will be marked in the View menu. This will show a row with status 
information at the bottom of the main screen. 

Installation and Operation manual v1.0    November 2003  Copyright  2003 by Aleen 



Music System 27 
Chapter  3. Music Software 

3.2.3 Communication 
The Communication menu contains the following functions: 

Function Description 

Read Configuration Read configuration information from the 
Music System 

Send Configuration Send configuration information to the Music 
System 

Read Recordings Read the list of audio files in the MUP 

Update Recordings Update the list of audio files in the Music 
System 

Backup Make a backup of the Music System database

Restore Restore the backup of the Music System 
database 

Software Upgrade Upgrade the Music System software 

Communication Selection Select the communication type between the 
PC and the Music System and define the 
locations of the device(s) 

Password Change the Music System password 

Reset Reset the Music System 
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3.2.3.1 Read Configuration 

To read the current configuration of the Music System: 

z Click on Communication  

z Click on Read Configuration 

 
z Click on OK 

 
z Click on OK to remove the message that the data has been received successfully. 

Now you are able to make changes to the configuration of the Music System. 
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3.2.3.2 Send Configuration 

To send the configuration to the Music System: 

z Click on Communication 

z Click on Send Configuration 

 
z Click on OK 

z Fill in the password 

 
z Click on OK 

 
z Click on OK to remove the message that the data has been sent successfully. 

The updated configuration data has been sent to the Music System. 
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3.2.3.3 Read Recordings 

To read the current list of music files in the system: 

z Click on Communication 

z Click on Read Recordings 

 
z Click on Recording Files List 

 
z Select the files to Read 

z Click on Set Path 
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z Click on Browse 

 
z Select the location you want the file to be downloaded to 

z Click on Open (to accept the location and given filename) 

z Click on OK 

z Click on OK 

z Click on OK 

 
z Click on OK when data has been received successfully 

The required music files have been downloaded from the system. 
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3.2.3.4 Update Recordings 

To Update the current list of music files in the system: 

z Click on Communication 

z Click on Update Recordings 

 
z Click on Recording Files List 

 
z Select a file number 

z Click on Set File 
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z Click on Browse 

 
z Select the location you want the file to be uploaded from 

z Click on Open  

 
z Set the volume level 

z Insert a description (Comments) 

z Click on OK 

z Click on OK 
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z Enter password 

z Click on OK 

 
z Click on OK when data has been transferred successfully 

The current list of music files in the system has been updated. 

Note: 

The music files should not be uploaded from the desktop or desktop folders as this will result 
in an error. 

The recommended MP-3 file configuration is:  

Mode: Mono 

Bandwidth: 22 kHz 

Bit Rate: 48kBps. 
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3.2.3.5 Backup 

To create a full backup of the Music System: 

z Click on Communication 

z Click on Backup 

 
z Fill in the backup filename (browse if you want to change the directory) 

z Click on OK 

 
z Click on OK to remove the message that the data has been received successfully. 

The backup file can now be used for another system or as a backup for the current system. 

Note: 

Before performing a Backup or Restore, always stop all running tasks. This is done by 
entering the Task Schedule window and change the end-time of all currently running tasks. 
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3.2.3.6 Restore 

To restore a full backup of the Music System: 

z Click on Communication 

z Click on Restore 

 
z Fill in the filename of the backup to be restored (browse if you want to change the 

directory) 

z If you used Browse, Click on Open 

z Click on OK 

 
z Fill in the password (default is 1234) 

 
z Click on OK after reading the warning and accepting the consequences 
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z Click on OK to remove the message that the data has been transferred. 

The Music System now contains all the information from the backup. 

3.2.3.7 Software Upgrade 

To upgrade the System Software (not the configuration data), make sure you have an RS-232 
connection to the Music System and that all running tasks have been stopped: 

z Click on Communication 

z Click on Software Upgrade 

 
z Browse for the upgrade file (*.BIN) 

 
z Click on Open 

z Click on OK 
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z Fill in the password (default 1234) 

z Click on OK 

 
z Click on OK to remove the message that the data has been transferred successfully 

3.2.3.8 Communication Selection 

The Communication selection defines the communication method, you will be using (via 
COM Ports or via the network). Apart from this the Music device button in this window, 
leads you to the Device Selection screen, which will be described in chapter 4.2.8. At this 
point the following steps have to be taken to select the communication method: 

z Click on Communication 

z Click on Communication selection 

 
z Select the used communication method (either Network or COM Port (including the 

number of the COM Port)) 

z Click on OK 

The communication method has been defined. 
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3.2.3.9 Password 

To input a new password: 

z Click on Communication 

z Click on Password 

 
z Fill in the Current (default) Password (default = 1234) 

z Fill in the New Password 

z Fill in the password in the Confirm New Password field 

z Click on OK 

 
z Click on OK to click away the message, that the password has been changed successfully. 

The password has been changed. 
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3.2.3.10 Reset 

To perform a hardware reset to the Music System: 

z Click on Communication 

z Click on Reset 

 
z Click in OK 

This will reset the Music System. 

3.2.4 Parameters 
The Parameters menu contains the following functions: 

Function Description 

Network Settings Define the network parameters for the Music 
System 

Date & Time Define the Date and Time on the Music 
System 
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3.2.4.1 Network Settings 

To set the network parameters for the Music System: 

z Click on Parameters 

z Click on Network Settings 

The following window will be shown: 

 
This information is essential for when you want to connect to the Music System locally. This 
information, together with the Communication Selection defines the communication flow. 

Note: 

The initial network setting can only be done via the RS-232 connection. 

3.2.4.2 Date & Time 

To go to the date and time parameters of the Music System: 

z Click on Parameters 

z Click on Date & Time 

The current window will show the date and time of the Music System (if connected). If the 
Music System is not connected, you will get the request to connect to the Music System. 

When the communication parameter to the Music System is set to COM 1 and there is no 
physical connection, a time-out error and an error that date and time to the device have not 
been set will appear. After the second error the Date & Time window will appear with the 
information from the PC. 
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3.2.5 Tasks 
The Tasks menu contains the following functions: 

Function Description 

Task Editor Define a task 

Task Schedule Schedule a task 

3.2.5.1 Task Editor 

The Task Editor windows contain 2 tabs, View Audio Files and Tasks. Before you are able to 
update the information in the Tasks tab, you will have to make sure that you have information 
in the View Audio Files tab.  

 
If not, add the Audio files via Update Recordings (Communications Menu). You can have a 
maximum of 100 file numbers defined (00-99). 

In the View Audio Files the following File number information can be edited: 

z Comments – This should describe the contents of the music/information file. 

z Volume – This is the playback volume of the music/information file (level 01 till 99, 
where 99 is the highest volume level). 
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The next step is to set tasks on the task tab. 

 
On the Tasks tab you have to define: 

z The task number – This number will be used when scheduling the chosen 
music/information. You can define up to 20 tasks. 

Within each task number the following information blocks need to be edited: 

z The Background Themes – This block defines which and how the background 
information will be presented. You can define 10 Background Themes per task. 

z The Interrupt Messages – this block defines which and how the extra information will be 
presented. You can define 10 Interrupt Messages per task. 

For the Background Themes you have to define and mark: 

z The Audio file number – This is the number of the Audio file that will be run in the 
background (this number is taken from the View Audio Files list). 

z Random play – Should you have more than 1 Audio file number defined, the system will 
play the selected Audio files at random. 

z External background – The Background music can also be created by connecting a radio 
or endless recording to the Music System. In this case this checkbox needs to be marked. 
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All other Background related settings will then be disabled. The interrupt messages will 
not be influenced. 

For the Interrupt messages you have to define and mark: 

z The Audio file number – This is the number of the Audio file that will be run, interrupting 
the background Audi file. 

z Cyclic play mode – This instructs the Music System to repeat the interrupt message(s) at 
a time, set by the Loop interval and Interrupt messages interval. 

z Loop interval – This instructs the Music System to repeat the interrupt message(s) at the 
specified time. 

z Interrupt messages interval – This defines the time between each interrupt message in the 
group of interrupt messages. 

Note: 

Background Themes and Interrupt Messages need to be marked from 1 till n where number 1 
is the first and n is the last. Unmarking a task in this range will result in an error message. 

3.2.5.2 Task Schedule 

The Task Schedule window contains 2 tabs, Daily Schedule and Holidays. 
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On the Daily Schedule tab, you are able to define the day of the week and the time for which 
a certain pre-defined task should be run. Per day you can set 10 tasks. A full day runs from 
00:00 to 23:59. 

 
In the Holidays tab, yearly holidays, the times and task to run, can be defined. 

The information is defined in the following screen: 
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3.2.6 Statistics 
The Statistics menu contains the following function: 

Function Description 

General Show product version and used and total 
memory size 

3.2.6.1 General 

To get the general statistics: 

z Click on Statistics 

z Click on General 

Now you will get a window, in which the software version of the Music System, total flash 
memory size and used flash memory size can be found. Close will take you back to the main 
screen of the MUP. 

 

3.2.7 Help 
The Help menu contains the following functions: 

Function Description 

Help Topics The Help function in the MUP 

About MUP Version information about the MUP software 

3.2.7.1 Help Topics 

To go to Help: 

z Click on Help 

z Click on Help Topics 

You will now be able to search in the Help module for the topics you need. 
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3.2.7.2 About MUP 

By clicking on Help and then on About MUP, you will get the version information of the 
Music Utility Program. 

 

3.2.8 Device Selection 
The Device Selection is a sub function in the Communication Selection window 
(Communication Menu). With this function you can select the Music System on which you 
want to perform maintenance. The following paragraphs contain the explanation of the 
window and examples of how to edit it. 

 
The left pane of the window provides a graphical tree of the available previously defined 
devices. The left pane contains the Root (which can’t be deleted) and can contain several 
Folders. These Folders can be used as separations between different Sub Folders and groups 
of devices. Each folder or Sub Folder contains one or more devices. The devices will be 
shown in the right pane. 

The functions in this window can be described as follows: 
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3.2.8.1 New Folder 

To create a new folder: 

z Click on Communication 

z Click on Communication Selection 

z Click on Select Device 

z Click on New Folder 

 
z Fill in the name of the folder 

z Click on OK 

z Click on Close 

Now the new folder has been created and the new device can be added to this folder. 

Note: 

For administrative purposes it is useful to fill in the contact information of the person 
responsible for this folder. 

It is possible to add another folder as a sub folder. 
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3.2.8.2 New Device 

To add a new device to the Folder: 

z Click on Communication 

z Click on Communication Selection 

z Click on Select Device 

z Click on the required Folder 

z Click on New Device 

 
z Fill in the Device Name 

z Fill in the Administrator’s password (default 1234) 

z Fill in the Music System version (optional, but advisable) 

z Fill in the IP Address 

z Fill in the complete contact information (optional, but advisable) 

z Click on OK 

z Click on Close 

Now the device has been added to the folder in the tree. 
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3.2.8.3 Delete 

To delete a Device and/or Folder: 

z Click on Communication 

z Click on Communication Selection 

z Click on Select Device 

z Click on the required Folder (and the Device) 

z Click on Delete 

z Click on Yes 

z Click on Close 

Now the Folder and/or the Device have been deleted, depending on the selection made. 

3.2.8.4 Edit 

To edit a Folder or Device: 

z Click on Communication 

z Click on Communication Selection 

z Click on Select Device 

z Click on the required Folder or Device 

z Click on Edit 

z Make the changes in the window 

z Click on OK 

z Click on Close 

Now the required change has been made to the Folder or Device. 

3.2.8.5 Select 

To select a Music System: 

z Click on Communication 

z Click on Communication Selection 

z Click on Select Device 

z Click on the required Folder and Device 

z Click on Select 

z Click on OK 

z Click on Close 

Now the Music System has been selected and you can start configuring the device. 
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3.2.8.6 Close 

Close closes the Device Selection window and closes it, bringing you back to the MUP main 
screen. 

3.2.8.7 Help 

This function opens the Help related to this window and functions in this window. 

3.3 File Types 
When working with the MUP software you will come across file of the following file 
extensions: 

z *.MUP 
This is the file containing all the configuration parameters, excluding the Audio files. The 
*.MUP file can be found in the same directory as ERAP.EXE and MUP.EXE, unless you 
have changed the location while saving or via the File/Options menu. 

z *.MP3 
This is a music file, used in the Music System. The *.MP3 file can be found in the same 
directory as ERAP.EXE and MUP.EXE, unless you have changed the location while 
saving or via the File/Options menu. 

z *.BIN 
This is the extension of the software upgrade file. This file can only be uploaded into the 
Music System when directly connected via the RS-232. When connected via the network, 
the function is grayed out. The *.BIN file can be found in the same directory as 
ERAP.EXE and MUP.EXE, unless you have changed the location while saving or via the 
File/Options menu. 

z *.MBU 
This is the backup file that will be created when performing a Backup action in the MUP 
program. This file can be used to restore the information of the Music System after a 
crash or corruption of the information (use the Restore function). The *.MBU file 
contains all the Music System configuration parameters and Audio files. The *.MBU file 
can be found in the same directory as ERAP.EXE and MUP.EXE, unless you have 
changed the location while saving or via the File/Options menu. 

z *.MDB 
This is the database with the device table data (information about the devices, Folders and 
Contacts). This file can be found in the same directory as ERAP.EXE and MUP.EXE. 

Notes: 

Should you want to transfer the complete device table to another computer with the 
installation of the MUP, copy the *.MDB file. 

The *.MDB and *.MBU files contain all the information needed to duplicate the complete 
installation of the current Music System, including the device table in the MUP. 
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3.4 IP-Remote Utility Program (E-RAP) 
E-RAP, the IP-Remote Utility Program for the Music System is the utility used for remote 
programming of the Music System device(s). This utility uses the same database with device 
information as the MUP utility and therefore the device information has not to be inserted 
again. 

The main window of E-RAP is shown below: 

 
The E-RAP Main window contains a Menu Bar, Toolbar, Status bar and four panes, which 
are described below: 

The Panes in the Main Window 

Left Pane With Shortcut Menus to Device List, Tasks 
and Reports 

Middle Pane With an overview of Task statuses or Root, 
Folder and Device information 

Right Pane With a one-line report of the task(s) or 
device(s) 

Bottom Pane With a real-time activity log of the tasks 
performed 
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The following function buttons can be pressed on the main window’s toolbar, when the 
action is allowed: 

Button Function 

 Create New Task 

 Create New Folder 

 Create New Device 

 Edit Selection 

 Delete Selection 

The following menu’s can be accessed via the main screen: 

Menu Item Functions in Menu Item 

File New Folder, New Device, New Task, Exit 

Edit Delete, Edit 

View Toolbar, Status Bar, Shortcuts Menu 

Help Help Topics, About E-RAP 

3.4.1 File Menu 
The File menu contains the following functions: 

Function Description 

New Folder To create a new collection of devices related 
to each other (device group) 

New Device To create a new device in a folder 

New Task To define a task to be performed 

Exit To exit the program 
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3.4.1.1 New Folder 

To create a new folder: 

z Click on the Device List in the left pane 

z Click on File 

z Click on New Folder 

 
z Fill in the name of the folder 

z Click on OK 

The new folder has now been created and the new device can be added to this folder. 

Note: 

For administrative purposes it is useful to fill in the contact information of the person 
responsible for this folder. 

It is possible to add another folder as a subfolder. 
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3.4.1.2 New Device 

To add a new device to a Folder: 

z Click on Device List in the left pane 

z Click on the required folder 

z Click on File 

z Click on New Device 

 
z Fill in the Device Name  

z Fill in the Administrator’s password (default 1234) 

z Fill in the Music System version (optional, but advisable) 

z Fill in the IP Address 

z Fill in the complete contact information (optional, but advisable) 

z Click on OK 

Now the device has been added to the folder in the tree. 
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3.4.1.3 New Task 

To create a new task: 

z Click on New Task in the left pane 

z Click on File 

z Click on New Task 

 
z Click on Browse to add target devices 
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z Select the required device 

z Click on the  button to add the device to the selection 

z Repeat the previous steps for all the required devices 

z Click on OK 

The device or devices have now been added to the Target Devices list. 

z Insert the date and time for the start and finish of the Task Execution 

z Add the number of attempts 

z Click on Browse to add Actions 

 
z Mark the required Action Type 

� MP3 File – Update of the Audio Files to the Music System (browse for the required 
Audio file, insert the Audio File number to which it should be connected, insert the 
required volume and add comments) 

� Configuration File – Update of the Configuration File (browse for the required 
configuration file (*.MUP) 

� Connection test – Test if there is a connection with the Music System 

z Click on OK 

Repeat the Task Action steps for all actions to be performed on the selected devices 

z Click on OK to add the Task to the queue. 

When the Task Execution takes place, the task is taken from the queue and executed. By 
clicking on the different Task statuses in the middle pane (see below). 
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Status information is shown in the right pane: 

 
The bottom pane will show the real-time activity log of the tasks performed: 

 

3.4.1.4 Exit 

To exit the E-RAP, IP-Remote Access Program: 

z Click on File 

z Click on Exit 

The IP-Remote Access Program will now be closed. 

3.4.2 Edit Menu 
The Edit menu contains the following functions: 

Function Description 

Delete Delete a selected Folder or Device 

Edit Edit a selected Folder or Device 
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3.4.2.1 Delete 

To delete a selected folder or device: 

z Click on Device List in the left pane 

z Click on the required folder or device 

z Click on Edit 

z Click on Delete 

 
z Click on Yes 

Now the folder or device has been deleted. 

Note: 

When deleting a folder, make sure the folder does not contain devices; otherwise you will get 
a warning that you cannot delete the folder. 

Clicking on the device and clicking on de delete button will also give you the Confirm 
deletion window. 

3.4.2.2 Edit 

To edit a selected folder or device: 

z Click on Device List in the left pane 

z Click on the required folder or device 

z Click on Edit 

z Click on Edit 

z Edit the Folder Details or Device Details 

z Click on OK 

Now the details have been edited. 

Installation and Operation manual v1.0    November 2003  Copyright  2003 by Aleen 



Music System 60 
Chapter  3. Music Software 

3.4.3 View Menu 
The View menu contains the following functions: 

Function Description 

Toolbar Show a row with buttons under the menus 

Status Bar Show status information at the bottom of the 
main screen 

Shortcuts Menu Show the left pane with action buttons 

3.4.3.1 Toolbar 

To view the Toolbar: 

z Click on View 

z Click on Toolbar 

 
The Toolbar function will be marked in the View menu. This will show a row with buttons 
under the menus. 

3.4.3.2 Status Bar 

To view the Status Bar: 

z Click on View 

z Click on Status Bar 

 
The Status Bar function will be marked in the View menu. This will show a row with status 
information at the bottom of the main screen. 
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3.4.3.3 Shortcuts Menu 

To view the shortcuts menu: 

z Click on View 

z Click on Shortcuts Menu 

 
The Shortcuts Menu will be marked in the View menu. This will show the action buttons in 
the left pane. 

3.4.4 Help Menu 
The Help menu contains the following functions: 

Function Description 

Help Topics The Help function in the E-RAP 

About E-RAP Version information about the E-RAP 
software 

3.4.4.1 Help Topics 

To go to Help: 

z Click on Help 

z Click on Help Topics 

You will now be able to search in the Help module for the topics you need. 
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3.4.4.2 About E-RAP 

By clicking on Help and then on About E-RAP, you will get the version information about 
the IP-Remote Access Program. 

 

3.4.5 Reports 
By clicking on the Reports button in the left pane, 

 
The Report window opens. 

 
In this window the following information is has to be filled in or marked: 

z Mark the Root, Folder or Device for which you want the report 

z Select the Report type 

� Device List Report – information about the selected devices 

� Tasks Report – information about the defined tasks, which tasks (in Task Status drop 
down menu) and Time Period (start and finish of the period) 

z Mark the Task Details 
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� Task Files list (list of the files handled by the tasks) 

� Cause of Failure (list of errors and reasons for it) 

z Mark the Device Details which you want to have specified in the report 

z Click on View Report 

Now the report is opened in Notepad and can be saved, printed and edited. 

z Click on close to close the Report window 
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4. MP3 File Size Calculation Table 
The following table shows the Maximum available recording time per MP3 file type. 
Mode Bandwidth  Bit-rate Quality File size for  

1 min. of 
recording 
time 

Maximum 
recording 
time 

Mono 8kHz 28 Kbit low 181 Kb 2h 50 min 
Mono 8kHz 48 Kbit low 362 Kb 1h 40 min 
Mono 16kHz 32 Kbit medium 248 Kb 2h 10 min 
Mono 16kHz 48 Kbit medium 361 Kb 1h 40 min 
Mono 16kHz 96 Kbit medium 722 Kb 45 min 
Mono 16kHz 128 Kbit medium 963 Kb 32 min 
Mono 22kHz 32 Kbit good 248 Kb 2h 10 min 
Mono 22kHz 48 Kbit good 361 Kb 1h 40 min 
Mono 22kHz 96 Kbit good 722 Kb 45 min 
Mono 22kHz 128 Kbit good 963 Kb 32 min 
Mono 44kHz 32 Kbit good 248 Kb 2h 10 min 
Mono 44kHz 48 Kbit good 361 Kb 1h 40 min 
Mono 44kHz 96 Kbit excellent 722 Kb 45 min 
Mono 44kHz 128 Kbit excellent 962 Kb 32 min 
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